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Teacher Technology Standards 

 
I. TECHNOLOGY OPERATIONS AND CONCEPTS 
Teachers demonstrate a sound understanding of technology operations and concepts. Teachers: 

A.  demonstrate introductory knowledge, skills, and understanding of concepts related to technology (as 

described in the ISTE National Educational Technology Standards for Students).  

B.  demonstrate continual growth in technology knowledge and skills to stay abreast of current and emerging 

technologies. 

II. PLANNING AND DESIGNING LEARNING ENVIRONMENTS AND 

EXPERIENCES 
Teachers plan and design effective learning environments and experiences supported by technology. Teachers: 

A.  design developmentally appropriate learning opportunities that apply technology-enhanced instructional 

strategies to support the diverse needs of learners. 

B.  apply current research on teaching and learning with technology when planning learning environments and 

experiences. 

D.  plan for the management of technology resources within the context of learning activities. 

E.  plan strategies to manage student learning in a technology-enhanced environment. 

III. TEACHING, LEARNING, AND THE CURRICULUM 
Teachers implement curriculum plans that include methods and strategies for applying technology to maximize 

student learning. Teachers: 

A.  facilitate technology-enhanced experiences that address content standards and student technology standards. 

B.  use technology to support learner-centered strategies that address the diverse needs of students. 

C.  apply technology to develop students’ higher order skills and creativity. 

D.  manage student learning activities in a technology-enhanced environment. 

V. PRODUCTIVITY AND PROFESSIONAL PRACTICE 
Teachers use technology to enhance their productivity and professional practice. Teachers: 

A.  use technology resources to engage in ongoing professional development and lifelong learning. 

B.  continually evaluate and reflect on professional practice to make informed decisions regarding the use of 

technology in support of student learning. 

C.  apply technology to increase productivity. 

D.  use technology to communicate and collaborate with peers, parents, and the larger community in order to 

nurture student learning. 

VI. SOCIAL, ETHICAL, LEGAL, AND HUMAN ISSUES 
Teachers understand the social, ethical, legal, and human issues surrounding the use of technology in PK–12 

schools and apply that understanding in practice. Teachers: 

A.  model and teach legal and ethical practice related to technology use. 

B.  apply technology resources to enable and empower learners with diverse backgrounds, characteristics, and 

abilities. 

C. identify and use technology resources that affirm diversity. 

D.  promote safe and healthy use of technology resources. 

E.  facilitate equitable access to technology resources for all students. 
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 How can Blogs be used in education? 
• Class Website: You can place your lessons, assignments, and announcements 

online; communicate with absent students; include web site links and upload 

worksheets;  Parents can submit comments in response to a request for volunteers 

or supplies to be donated  

• Class Newsletter: Unlike an e-mail newsletter or a print newsletter, a blog entry 

is in no danger of not getting to its intended audience because it got caught in a 

spam filter or discarded on the walk home from school. Plus, if you include an RSS 

link parents can subscribe to your newsletter. 
• Class Blog: instruction tool with students contributing to the blog such as a 

current events discussion, or a book study, creative writing 

• Department/Grade Level Blog: teachers can collaborate and share ideas, have 

virtual meetings, plan parent/teacher conferences 

• Cadre/Committee Blog: members can have virtual meetings, sharing ideas while 

viewing others’ ideas, collaborate on a group project, etc. 

• Professional Development Book Study: members can have virtual meetings 

sharing reflections and applications of a book study. 

• Mentors/Protegee: New teachers can use blogs to reflect on their experiences 

and their mentors can comment. 

• Student Team Blogs: students collaborate on a project; Students who are not in 

the same science class physically, but are in one of Mrs. Rummel’s 8th grade 

science classes, collaborates with other 8th grade science students assigned to 

study Jupiter. Or, student in another District, State, or Country collaborate on a 

project using a blog. 

• Blogging Buddies: like penpals, but better 

• Writing Club: students post  their work to a blog, fellow members comment on 

work 

• Student Journals: Students can blog their reflections and the teacher can 

conveniently leave comments without collecting 25 spiral notebooks.  

• Student E-portfolios: Students can publish their work on-line, or use it as a 

digital filing cabinet for their work. Comments can be posted by parents, aunts, 

grandparents, etc. 

• Activity Updates: Clubs and activities, sports teams, and parent groups use 

Weblogs to post scores, meeting minutes, and links to relevant issues and topics.    

• Building Announcements/Principal Memos: These bulletins would then be 

archived for later reference; teachers could subscribe to the bulletins and 

automatically receive notification of new postings. Staff members could comment 

on posts. 

• Registration Blog: Workshop registration process could be completed using a 

blog. The facilitator posts an invitation, all those interested respond with a 

comment. 
• Companies serving the education community are using blogs to provide 

educators with information that supports teaching and learning.  

• Professional organizations and associations are also using blogs to reach out to 

their members and the greater community.  
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Blog Advantages 
• Convenience and Simplicity: Can be utilized from any computer connected to 

the Internet. You don’t have to be logged in to your school station/network to 

make changes to your blog. 

• Social/Collaboration: A blog can have several authors or contributors with 

varying levels of access for publishing comments or posts and other content. 

• Engaging/Motivating for Students 

• Interactive 

• Multiple Learning Styles: Blogging appeals to multiple learning styles. 

• Context for Learning: students can create real products for a read audience and 

get real feed back.  

• Encourages Reflection 

• Tech/Work Place Skills: Students learn technical skills for the workplace.  

 

WordPress 
WordPress is blogging software that helps you publish to the web instantly, whenever the 

urge strikes, from any computer connected to the Internet. More specifically, instead of 

publishing your posts in Mozilla Composter and uploading to a server, you make posts to 

your blog by submitting a simple form on the Edublog web site, and the results 

immediately show up on your site, with your design. 

 

Edublog 
Edublog is a free, weblog-hosting service for educators and students that uses WordPress 

software. There are other weblog services/websites that also use WordPress, or other 

blogging software. 
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Setting Up Your Edublogs Account 
 

1. Using your browser, navigate 

to Edublogs.org at: 

http://edublogs.org  

2. Click the Sign up for FREE big 

blue button. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Enter a Username.  

 

4. Enter your school email 

address. If you type an 

incorrect email address, you’ll 

have to start over and the 

great name you originally 

chose for your blog will no 

longer be available.  

 

 

 

 

5. Click the I Agree box. 

 

6. Enter the Verification 

code. 

 

 

7. Click the Next >> button.  

 

 

 

 



3/19/2008  7 

8. At the next screen you will see 

your Blog Domain, the url address 

to view your blog. You can change 

this if preferred. 

9. Enter a Blog Title. This can be 

changed later if necessary. 

10. Set the Privacy option according to 

your preference. 

 

 

11. Click the Signup >> button. 

 

 

 

 

12. This confirmation message will be 

displayed. You need to look for an 

email with a link for activating your 

blog. This email could take hours to 

arrive. You can close this browser 

window. 

 

 

 

13. When you receive the 

Activate email, similar to the 

one pictured below, click on 

the link to start your browser 

and activate your new 

edublog account. Or, you can 

copy and paste the link into 

your browser if necessary. 

 

 

 
14. This is what you should see. Make 

note of your username and password 

for future reference. 

15. You can then choose to Login with the 

provided link. 

 

 
16. You will then receive the second 

email with your blog address, login 

address, username and password. 

It would be a good idea to save 

or print a hard copy of the 

email for future reference. 
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Your Blog Web Address 
Based on the preferences you set up, other people may be able to view and/or comment 

on your blog at this web address: http://username.edublogs.org 

 

Your Blog’s Features 

Your blog’s homepage will be a list of your postings in chronological order. It is like a river 

of news. 

 

Side Bar  
• Pages: These are static pages that you create, not posts or comments. Examples 

include About Mrs. Carey, Our Schedule, Supply List, Calendar, etc. Currently an 

About page exists. You can add more pages or delete the About page and not have 

any pages. 

• Archives: links here will display monthly chronological views of your posts, this 

does not include Pages. 

• Categories: You can choose to use Categories to label your posts. This helps 

readers locate posts on a particular topic without scanning through a list of 

chronological postings. For example: Today’s Assignments, Homework, 

Newsletters, Spelling Words, etc. A category is not displayed on your Blog 

navigation  until it contains posts. 

• Blogroll: This displays a list of web links of your choice. Categories can be used 

here to organize links. 

• Meta: Author tools: Site Admin, Logout/Login (maybe a few other links that you 

won’t use often) 
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Posts 
In the middle of your page is a chronological list of your posts. The title of a post is a 

clickable link that will take you to a full-page view with any comments. Currently it 

displays only one post, “Hello world!” which was posted Edublogs. Later we will delete 

this.  

 

 

 

 

 

 

 

 

 

 

At the end of each post, you will see:  

 

• Categories assigned to that post 

• An Edit link (if you are logged in): you can edit the post. 

 

 

 

 

 

 

 

 

 

 

 

 

 

• The number of Comments for that post: Clicking on the Comment link will take 

you to the comments posted including a form to post a comment.  
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Logging in to Your Dashboard 
1. In your browser, navigate to your blog address: 

http://username.edublogs.org 

Just substitute your username in place of the username text in the 

address. For example: http://jgarton.edublogs.org 

2. Look for the Meta widget* on your blog and click the Login link.  

 

 

 

3. Enter your Username and Password.  

4. Check the Remember me box only if you are the only user of 

this particular computer. 

5. This takes you to your Site Admin settings for your blog. It 

opens at the Dashboard page. 

 

If you have LOST your password, click the provided link. 

 

*If your blog does not have a Meta widget, navigate to: 

http://username.edublogs.org/wp-login.php 

 

 

Your Dashboard 

• In the upper right corner is your user name, a Sign out link, and a link your Profile. 

• Below this is a light blue bar with links to pages: Dashboard, Write, Manage, etc.  

• To the right of your blog’s Title is a “View site” link. Clicking this will display your 

blog.  
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Update Your Profile and Password 
 

1. From your Dashboard 

page, click the Users 

page and the Your 

Profile tab. Here you can 

change your password 

and enter any other 

information you prefer. 

2. I would recommend 

leaving checked: Use the 

visual editor when writing. 

3. Be sure to click the 

Update Profile button to 

save your changes. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Nickname: you can enter a name to be displayed with your posts.  

Display name publicly as: use this drop down menu to select the name to be displayed 

by your posts. 

First/Last name: what’s displayed when someone clicks on your nickname to view your 

profile. 

About Yourself: an area that is displayed in some themes. 

Email: your email address is not displayed on your blog or in your profile. 
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Adding Authors & Users 
Typically, the administrator of a blog is the only one who can publish posts, pages, and 

has control over visitors’ comments. Visitors can post comments, if allowed, but cannot 

publish posts or other content. If you would like other users to have access to these 

features of your blog you can use the Authors & Users tab on the Users Page to set them 

up. The users must be registered at Edublog. The role that you assign a user defines how 

much they can do.  

• The Administrator: access to all the options 

• Editor: publish posts and pages; manage posts, pages, comments, uploads, 

categories; moderate comments; manage and edit the blogroll; edit the profile;  

• Authors: publish posts; edit and delete their own posts; manage uploads and 

some comments, moderate comments. 

• Contributor: write posts that must be approved by an author, editor, or 

administrator before being published; moderate comments; 

• Subscribers: publish comments 

 

1. Click Users. 

2. Scroll down to the Add User From Community section. Enter the appropriate email 

address for the new user (it has to be the email address they used when 

registering for Edublogs). 

3. Choose the Role. 

4. Click the Add User button. 

 

 

 

 

 

 

 

 

 

 

 

5. You should now see the new user listed. 
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Update General 

Options 
 

1. Click the Options page and 

choose the General tab. 

2. Correct Time if necessary. 

3. Make changes according to 

your preferences. If you 

plan on allowing comments 

from students, parents, 

and/or coworkers I would 

uncheck the Membership 

box. 

4. Click the Update Options 

button. 

 

 

 
 
 

 

Set Reading Options 
 

1. Click the Options page and choose the 

Reading tab. 

2. Front Page: what do you want 

displayed on your front page/home 

page. 

3. Blog pages: can set how many posts to 

show on home page, or how many days 

of posts to show. 

4. Syndication Feeds sets options for 

feeds sent out to people who subscribe 

to your blog using an aggregator.  

5. Make any changes according to your 

preferences. 

6. Click the Update Options button. 
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Set Discussion Options 
 

1. Click the Options page and choose the Discussion tab. 

2. I would recommend choosing the options in the image below. This will enable 

comments on your blog, but you will have to approve them before they appear. 

You will also receive an email notifying you of any comments awaiting moderation. 

3. If you do NOT want to allow comments, uncheck the Allow people to post 

comments on the article under Usual settings for an article. 

4. These setting may be overridden for individual posts or pages. 

5. Click the Update Options button. 
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Choosing AMP Options 
These are option for the Anarchy Media Player which is the player that appears in your 

post or page when you embed a media (video, mp3, etc). 

1. Click the Options 

menu and choose 

AMP.  

2. In the Anarchy Media 

Player Options, MP3, 

and QuickTime boxes I 

would recommend 

checking the boxes 

that enable your 

readers to download 

the media, as opposed 

to just streaming it. 

Streaming using a lot 

of bandwidth and the 

quality of playback is 

effected by the 

reader’s connection.  

3. Click the Update Options button. 

 

Activating Plugins 
Plugins are bits of programming scripts that add additional functionality to your blog. 

These are the only plugins available for you to use on the Edublogs server. New plugins 

are frequently added. Plugins I recommend: Advanced Editor, Subscribe to Comments, 

and Akismet. 

 

1. To activate a plugin click the Activate link in its row.  
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Write a Post 
 

1. Click the Write menu and choose Write Post tab. 

2. Enter a title for you Post in the Title field. Avoid using the same title twice as that 

will cause problems. You can use commas, apostrophes, quotes, hypens/dashes, 

and other typical symbols in the post like "My Site - Here's Lookin' at You, Kid". 

WordPress will clean it up for the link to the post, called the post-slug. 

3. Use the Editor tab to enter your post content.  
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Visual Editor Toolbar 

 

 
 

 

 

Font Format, Bold, Italic, Underline, Strikethrough 

 

Link, Unlink, Insert/Edit an Anchor, Set Picture 

Properties, Insert Horizontal Ruler 

 

Subscript, Superscript, Text Color, Highlight Color, 

Insert Custom Character 

 

Paste as Plain Text, Paste from Word, Select All 

 

Embed Flash swf file, Embed Media Links YouTube 

etc 

 

Bullets, Numbered List, Indent, Outdent 

 

Alignment 

 

Spell Check 

 
Undo, Redo 

 

 

If you do not see all these buttons:  

Click the Plugins menu. Locate the Advanced Editor row and click the Activate link. The 

next time you view the editor you should see more button. You may have to click the 

refresh/reload button on the Write page/post for this plugin to take effect. 
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4. On the right side are boxes that you can open and close using the 

+/- sign in the title bar.  

a. Categories: Choose a category, or categories, for this post, 

or use the Add button to create additional categories as 

needed.  

b. Discussion: choose Allow Comments or Allow Pings. This 

will override what you set in the Options>Discussion tab. 

Allowing comments makes your blog a social, interactive 

tool. This option is turned on by default, but you can turn it 

off. Pings are a way for a conversation to take place over 

several blogs.  

c. Post Password: If you have sensitive information 

appropriate for only some viewers, use a password.  

d. Post slug: This is the web address for the post you are 

currently creating. If you do not like the default, which 

include the title of your posts, type something else. 

e. Post Status: set your post as Published, Draft, or Private. 

f. Post Timestamp: change the date and time for the 

posting; you could publish the week’s assignments in 

advance and future date the post so that it appears on the 

appropriate day. 

5. Click Publish to save and to publish your post to your blog. Other 

choices include: 

a. Save and Continue Editing: to save your post, not 

publishing it, but allow you to continue editing it. 

b. Save: save, but not publish. 
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Adding Images or Documents  

You can upload images files (jpg, gif), document files (Word, Excel, PowerPoint, PDFs but 

not Publisher), and videos (up to a size of 10MB). The image can be displayed in a post, or 

just a link to the image. A link to upload document can be embedded in a post. You have 

150MB of storage with a free account. To get more storage use the DivShare Upload 

plugin, a plugin.  

 

1. From the Write tab, in the Write Post tab or Write Page tab, scroll down below 

the post area until you see the area for uploading.  

2. Click the Browse… button and navigate to the area of your computer that has the 

file that you wish to upload. 

3. Click the appropriate file to select it and click the Open button. 

4. You may enter a title. If you leave it blank, WordPress will use the file name for the 

title. So, if you are uploading a document I would recommend entering a title. 

5. Click the Upload button.  

 

 

6. If you uploaded an image, the Browse tab now displays your uploaded image and 

these choices:  

a. Show 

• Thumbnail: insert a thumbnail of the image 

• Fullsize: insert the image full size 

• Title: display hyperlinked title/file name of image  

b. Link to 

• File: link to the image file, clicking on it would display a larger view of 

the image. 

• Page: link to the Page in your blog with the image file name for a title 

• None: image not linked 

7. If you uploaded a document, the Browse tab now displays a link to your file and 

these choices:  

 

 

8. Send to Editor: send image up to the Post content area. Place the cursor in the 

post where you want the image to appear and click the Send to Editor link.  
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9.  If you would like the text to wrap around the 

image, select the image and choose the image 

button at the top of the editor.  

10. Use the Alignment drop down menu to choose 

your preference. Left or right is typical. 

11. Here you can also change the description, set the 

border, vertical or horizontal space. Click the 

Update button. 

12. To resize the image, click once on the image in 

your editor to select it. Then drag one of the corner 

handles. 

 

 

Inserting a Hyperlink in a Post or Page 
 

1. Type in a title for your link.  

2. Highlight your title. 

3. Click the link button .  

4. Paste in the URL. 

5. In the Target field I usually choose Open in a 

new window so that my blog will remain open 

while readers access this link in a new window.  

6. Click the Insert button. 
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Write a Page 
Creating a page is very similar to creating a post. Pages behave differently than posts in 

your blog. They are mostly used for static content that rarely needs updating. Examples 

include: about, class rules, schedule, school calendar, supply list, resume, syllabus, 

meeting rules, etc. 

 

   

 

 

 

 

 

 

 



3/19/2008  22 

Placing Hyperlinks in Your Sidebar with 

Blogroll 
The Blogroll, Link Widget, is for creating hyperlinks. Bloggers usually include links to other 

Blogs that they read in their Blogroll. 

 

Add Link 
1. Click Blogroll and Select the Add Link tab. 

2. Enter a name. The Name is what will appear in your Blogroll as the hyperlink.  

3. I would recommend copying and pasting the link Address, as opposed to typing it 

in.  

4. The Description is not required. You can enter/choose a category for a link.  

5. Look for the box on the right entitled Target. Here you can set the link to open in 

a blank window, as opposed to the current window your blog in which your blog is 

displayed. 

6. Choose a Category for the link. If you don’t, it won’t display. 

7. Click the Add Link button to publish. 

 

 

 

If you like to have a lot of links and the Blogroll is too small of a space, I would suggest 

creating Pages for your links. You could have a Social Studies page with links, or a 

Fractions page with links, a Teacher’s Resources page, etc. Links can also be included in 

Posts. 
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Adding Your Blog Roll to Your Sidebar 
If your Blog Roll does not appear in your sidebar you need to add that Links widget to your 

sidebar. 

 
1. Click Presentation 

2. Click Widgets 

3. In the Available Widgets box you 

should find one labeled Links. Drag this 

up into your sidebar. 

4. Save Changes. 

 

 

 

 

Manage Blogroll 
To edit your link click Blogroll and select Manage Blogroll. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Including an Image with a link in your Blog Roll 
1. From your dashboard, click Blogroll. 

2. Click Add Link. 

3. Enter the Name and Address for the link. 

4. Scroll down to Advanced and paste in the Image Address for the image you want to 

use. The image has to already be uploaded and available on-line, such as on your W: 

drive on on flickr.   

5. Save Changes. 
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Edit or Delete Posts 
Click the Manage page and choose the Posts tab. From here you can view, edit, or delete 

any post on your blog. You can also search by keyword, browse my month or category. 

 

 

 

 

 

 
 

 
 

 

 
Edit or Delete Pages 
Click the Manage page and choose the Pages tab. From here you can view, edit, delete 

pages; search your pages by keyword; and create a new page.  

 

 

 

 

 

 

 

 

 

 

 

Manage 
Uploads 
 

1. Click the Manage page 

and choose the Uploads 

tab.  

2. Click on a file to edit or 

delete it.  
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Manage Comments 
 

1. Click the Manage tab and 

choose the Comments tab.  

2. Here you can search comments 

by keyword. Or, for each 

comment you can edit, delete, 

unapprove, spam, and view 

post. 

 

 

 

 

 

 

 

Comments Awaiting Moderation 
If you have set up your blog to where comments require preapproval, the comments will 

appear here for your approval prior to being published on your blog. Here you can edit, 

delete, approve, spam any comments waiting for moderation.  

 

1. Click the Manage page and choose the Awaiting Moderation tab. 

2. Check the box next to a comment and choose the appropriate action: edit, delete, 

approve, or spam. 
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Choose Your Presentation 
 

1. Click the Presentation page. At any time you can select a new Theme for your 

blog. Different themes feature different Navigation areas and options that you can 

not change.  

• If you plan to use a lot of static Pages don’t use a theme that has navigation 

links that run across the top of the page. 

• If you plan on using a lot of images in your posts, don’t use a theme with a 

narrow content area. 

• The RSS link on some presentations does not work. 

2. When you see a theme that you want to try, click once to select it. Then click the 

View site > link at the top to get a better view. If you are not happy with this 

choice go back to the Site Admin and choose a different Presentation theme. 

3. If you choose a Theme that has option tabs, such as those in the example below: 

Header Image and Color and Sidebar Widgets, you can click on those to further 

customize your blog.  
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Dress Up Your Sidebar With Widgets 
Widgets are the items that 

appear in your sidebar, 

such as categories, 

calendar, archives, etc. 

 

1. Click Presentation 

and click the 

Widgets tab. 

 

 

 

 

 

 

2. Scroll down to view the available widgets. 

3. You can drag and drop the widgets up into the sidebar(s). 

 

 

4. You can rearrange the widgets in the sidebars with a click and drag. 

5. Some widgets have a configuration button  that you use to set further 

options. 

6. Click the Save Changes button when you are finished. 

 

 

Below the Available Widgets box are options to 

choose how many Text, RSS Feed, WidgetBox, and 

Video Widgets you want. 
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Widgets I recommend 
 

 

 

 

 

 

 

Links: your blogroll                                

 

 

 

 

 

 

 

 

 

 

 

RSS: readers use to subscribe to your blog 

 

RSS 1 Or RSS Subscribe 

 

 

 

 

Other Widgets and Their Uses 
 

Sonic Songspots: plays a song of your choice 

 

Recent Posts: latest posts 

 

 

 

 

 

 

 

 

 

Recent Comments: newest comments on your blog 

 

Search: search your blog 

 
 

 

Text box: enter your 

own title and text or 

paste in html code; you 

can have up to 9 text 

widgets 
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Flickr: Display a Flickr badge with your photos from Flickr, you 

choose the set 

 

Delicious: display your delicious tags 

 

 

 

 

 

 

 

MyBlogLog: shows recent visitors to your blog (they have to be 

a member at MyBlogLog).  

 

Avatar: displays the avatar you have 

uploaded to Edublogs 

 

 

 

 

 

Box.net file sharing: displays a list of files you have 

uploaded to Box.net for others to download. You will need an 

account at this free site. 

 

Google Search: a google search box 

 

 

 

Picasaed: display pictures from your Picasa web album 

 

Twitter: displays the tweets from the people 

you follow with your Twitter account 

 

 

Video 1 Widget: embed video from YouTube, 

Google Videos, etc. 

 

 

 

 

 

 

 

 

Vod:Pod Videos 

 

Widgetbox 1: Choose from hundreds of widgets from 

the Widgetbox site; See video tutorial on process 

here:  

http://video.google.com.au/videoplay?docid=-

7847916051934215439&hl=en-AU 
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Logout or Sign Out 
If you do not log off before closing your blog site, the next time that web address is 

accessed from this station, you will still be logged in. 

• From your blog you can click Logout usually available in the Sidebar under Meta.  

• From your Dashboard area you can click the Sign Out link in the top right hand 

corner.  
 

Creating Additional Blogs 
You will use the same user name and password with all your blogs created from the same 

email address. You will just have a different blog URL address for this new blog. 

1. Login to your blog. 

2. Navigate to: http://edublogs.org/wp-signup.php 

3. Complete the form and click the Create Blog button. 
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Blogging With Students 
 

Examples of Student Blogging 
Blogs are a wonderful vehicle for students to use to publish to a worldwide audience, and 

receive feedback. Some examples of student blogging include:  

• Scribe for the day: student post notes about that day’s class, or even 

demonstrate skills learned 

• Work samples: student published documents or creative writing; photos of 

projects or artwork; embed videos, slideshows, podcasts, etc. 

• Reflections: students reflect on their learning 

• Book Reviews: students post book reviews  

• Building News: students publish class announcements, reminders, report on  

activities and events, post polls and surveys, post school photos 

• Teacher question posts: the teacher posts a question and the students all 

respond with a comment. 

• Collaborative projects: using a blog to communicate and collaborate when 

working with another class on a project  

• Historical fiction: students write blog posts from the view point of a historical 

figure or during a time in history.  

• Audio posts: Students recordings/podcasts can be posted on the blog (read 

creative writing, their own poetry).  

• Scientists: Student post data, photos, or videos during a science activity. 

 

Develop a Class Blogging Policy 
Here are some possibilities: 

1. I will not give out any information more personal than my first name. This means 

no pictures myself, age, email address, home address, school name or location, 

phone numbers, or other sensitive information. 

2. I will not link to other sites that can identify my geographical locations, such as a 

school or district website.  

3. I will not share my password with anyone besides teachers and parents. 

4. If I see something online that makes me uncomfortable or afraid, I will minimize 

my screen immediately and report this to my teacher. 

5. I will take blogging seriously, posting only things that are meaningful and taking 

my time when I write. 

6. I take responsibility for what I post on the blog. I will only post pieces that I am 

comfortable with everyone seeing (teachers, family, clergy), even 10 years from 

now (colleges, employers, coworkers). 

7. I will use my blog as an extension of the classroom, posting on any school-

appropriate subject. 

8. I will express my ideas, while not over generalizing or making derogatory or 

inflammatory remarks. 

9. I will use only constructive criticism.  

10. I will support any idea, comment, or critique I have with evidence.  

11. I will only post comments on posts that I have fully read. 

12. I will evaluate what I find online.  

13. I will be respectful of others and their opinions. 

14. I will not insult my fellow students or their writing. 

15. I will not bully others in my blog posts or in my comments. 
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16. I will never access another student’s account. 

17. I will not provoke other students in my blog posts or comments. 

18. I will not reveal anyone else’s identity in my comments or posts. 

19. I will use language appropriate for school. 

20. I will try to spell everything correctly and use correct grammar. 

21. I will not plagiarize. I will abide by copyright laws for anything posted on my blog 

including videos, images, audio files, etc. 
22. I will not spam. 

Follow Through With Consequences  
• Warning 

• Deletion of some or all of the post 

• Temporary loss of blogging privileges 

• Detention 

• Suspension 

• Permanent loss of blogging privileges 

 

Set Teacher Controls 
• Approve all student posts prior to publication. With older students, teachers can 

use their judgment as to if this is necessary during the entire course. If the teacher 

views the blog’s content frequently, any issues will be identified and dealt with 

quickly. 

• Approve all comments prior to publication. 

 

Educate the Parents 
• If the student’s Technology Usage Agreement gives him/her permission to post 

work online, then he/she may participate in a blog.  

• However, you should still educate the parents on the educational benefits of 

blogging and the safety procedures that are in place.  

• Encourage parents to visit the blog and leave comments.  

• Share the Class Blogging Policy. 

Teach Student to be Successful Bloggers 
• Read blogs  

• Accept the challenge of blogging to their personal best 

• Show improvement in their posts, with practice and guidance from others  

• Keep the focus of blogging on academic collaboration insightful  

• Frame thought-provoking questions at the end of their blog entries that will invite 

valuable comments 

• Follow writing conventions  

• Respond to posts by others, either through comments, or by writing a post 

• Connect to a larger community of learners 

• Compose posts that include textual references to support opinions 

• Respect others 

• Celebrate their successes and those of their peers 
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Teach Students to Comment Like a Pro 
• Moderate student comments 

• Write meaningful comments that add to the conversation. 

• Don’t be afraid to comment, even if you are a new blogger. 

• Show the author that you hear them. “I hear you saying….” 

• Use your comment to show why you think the topic is important. 

• If you’ve written about it, link to your post. 

• Read the comments posted after yours. 

• Be respectful of other people and their opinions. 

• Constructive criticism only, no derogatory or inflammatory remarks  

• Model good spelling and grammar 

• Support yours comment with evidence.  

• Only comment on post that you have fully read  

Comment Starters 

• This made me think about....... 

• I wonder why....... 

• Your writing made me form an opinion about....... 

• This post is relevant because....... 

• Your writing made me think that we should....... 

• I wish I understood why....... 

• This is important because....... 

• Another thing to consider is....... 

• I can relate to this....... 

• This makes me think of....... 

• I discovered....... 

• I don't understand....... 

• I was reminded that....... 

• I found myself wondering....... 
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Create a monitored blog for each student 
3/19/08: Edublogs has added a new feature that allows you to set student blogs with you 

as the administrators. Please see Mr. Farmer’s screencast tutorial at:  

http://edublogs.org/2008/03/11/simply-create-blogs-and-usernames-for-your-students/ 

 

Creating the blogs 

1. Log in to your blog, if necessary. 

2. Navigate to: http://edublogs.org/wp-signup.php 

3. For your first student, create a blog domain name, which creates the web address 

for the blog. 

4. Choose the privacy level. 

5. Enter the title. 

6. Choose Student for the 

Blog type. 

7. Click Create Blog and 

proceed to complete 

the process. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
8. You should see the confirmation 

message. 

9. Make a note of the provided URL. 

10. Repeat this process for each of 

your students. 
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Creating student Edublogs accounts 

1. Register your students for 

edublogs using their epals email or 

a gmail alias, but don't register for 

a blog, just a username. Student 

usernames will display with 

posts so be careful what you 

choose.  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
You can control what name is displayed with each post 

by clicking the Users menu and choosing the Your 

Profile tab. Use the drop down menu for Display name 

publicly as, to make your choice. 

 

 
2. Repeat this process for each of your students. 
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Adding Students as Contributors to Their Blogs 

For each of the student blogs you created, you will now add the appropriate student as a 

Contributor. That means their posts will have to be approved by you, the blog 

administrator, before they appear.  

6. Navigate to the blog for your first student by typing in the URL. 

7. Log in if necessary. 

8. Click Users. 

9. Scroll down to the Add User From Community section. Enter the appropriate email 

address for the student. 

10. Choose Contributor for the Role. Or, if you aren't concerned about preapproval of 

posts choose Authors. 

11. Click the Add User button. 

 

 

 

 

 

 

 

 

 

 

 

12. You should now see the student listed in the Contributor section. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

13. Repeat this for each of your students. 
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Create One Class Blog to Which all Students 

Contribute  
1. Signup for an Edublog blog. See the section at the start of this document for 

directions. 

2. Signup each of your students for an Edublog account with a username only, using 

their epals email or gmail alias. See the previous section entitled Creating student 

Edublogs accounts for directions. 

3. Add each of the students as a contributor to the class blog. See the previous 

section on Adding Students as Contributors to Their Blogs for directions. 

 

Using Gmail Aliases to Register Your Students  
With a gmail account, you can receive messages sent to your gmail address AND a gmail 

alias, yourusername+any.alias@gmail.com. For example, messages sent to 

jgarton+notes@gmail.com are delivered to jgarton@gmail.com. 

 

1. Create a gmail account at: https://www.google.com/accounts/ManageAccount. 

2. Create student blogs with email alias accounts by using the plus (+) sign and 

student first name 

 

yourusername+studentfirstname@gmail.com  

jgarton+billy@gmail.com 

 

• you can have as many aliases as you like per Gmail username 

• the bit after the "+" sign in the alias can be just one character long, or longer if 

you wish, and can consist of letters and numbers.  

• you can apply Gmail filters to individual aliases to help organize your 

correspondence  

3. All the authorization and management matters related to your students’ blogs will 

come to your gmail account. 

 

 



3/19/2008  38 

Advanced Tips 
 

Embedding Flash  
Many sites provide code for flash objects (swf) that you can embed in your blog or 

webpage. Rather than copy the entire code, for edublogs you just need the link. 

 

1. Copy the link to the actual thread out of the code. For example, here’s the provided 

embedding code: 

 

 
 
From which we copy: http://voicethread.com/book.swf?b=3088 

 

2. Make a note of the height and width of the object.   

3. Click on the Embed Flash swf button  in 

your Write Post Visual Editor. 

4. Paste the link in using the keyboard 

shortcuts Ctrl V, or right click in the box 

and choose paste from the context menu.  

5. Click OK. 

 

 

6. Enter the width of the object. You can use 

the original size from the embedding code, 

or resize it by entering different numbers.  

7. Click OK. 

 

 

 

8. Enter the preferred height. 

9. Click OK. 

 

 

You will now see: 

 
 

10. To preview the flash click the Save and Continue Editing button. Then scroll down 

to view the preview of the post. 
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Anchors  
Anchors are hyperlinks to a different location on the same web page.  

1. Type in your text for the link and the content. 

 

2. Position your cursor where you want the link to point to, and click the anchor 

button in the editor. 

 

 

 

 

 

 

 

3. Enter a logical one word label for this anchor. For example, if the link text was 

Kidspiration, I would type kidspiration for the anchor. 

4. Click Insert. A blank space will appear where your cursor was.  

5. Click the html tab for the editor.  

6. Locate the text for your hyperlink and make it look like the example below, with 

#kidspiration being the name of your anchor and Kidspiration being your hyperlink 

which is already there. 

<a href="#kidspiration">Kidspiration </a>  

7. Save and check your links to see if they work as you intended. 
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Blog Tag Generator and Pinging Technorati 
 
Tags are used to describe your post, categorize it. They can also be used to draw readers 

to your blog. You can use the Blog Tag Generator to create a list of hyperlinked tags for 

your blog post, which is usually placed at the end of your post. 

http://landmark-project.com/blogtags.php 

 

1. After writing your post and 

navigating to the Blog Tag 

Generator, enter the keywords 

for your post using spaces 

between each word. 

2. Click the Submit button. 

3. Copy the provided html code. 

4. Enter your blog address into the 

Ping Technorati box and click the 

Ping! Button. Many people use 

Technorati to locate blog posts.  

5. Navigate back to your blogpost. 

6. Click the html tab at the top of 

the editor. 

7. Place your cursor at the end of 

your post. 

8. Right click and choose paste from 

the popup menu. 

9. Save your post. 
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Avatar 

An avatar is an Internet user's representation of himself or herself. This avatar will be 

visible on comments and blog listings across Edublogs. You can also choose to display 

your avatar in your sidebar by including the avatar widget in your presentation. I used the 
free site Meez (http://www.meez.com) to create my avatar. This site is blocked at school. 

1. Click the Options menu and choose the Avatar tab. 

2. Click the Browse button and navigate to the image file (jpeg, gif, or png) you want to 

use. You are able to crop it after you have uploaded it. 

3. Click the Upload Image button.  

 
 

 

 

4. The next window provides 

handles on your image 

that you can click and 

drag to crop it. 

5. Click the Crop Image 

button.  

6. The Finished window will 

be displayed. 
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Google Maps Plugin 
Setting Up the Plugin 

1. Go to Plugins and click the Activate link for Google Maps. 

 

2. Go to Options and click on Inline Google Maps 2. 

3. Click the link: You can sign up Google Maps API key here. You must have a Google 

Account to get a Maps API key, and your API key will be connected to your Google 

Account. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Scroll down check that you agree to the terms. 

5. Type or paste in your blog URL. 

6. Click the Generate API Key. 

 
7. You can then login with your existing Google email and password. Or, if you don’t 

have an account, click the Create an account now button and setup an account. 
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8. After logging in to Google, copy the key provided in the top box. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. Navigate back to your blog. 

10. Paste in the key at 

Options>Inline Google Maps 2. 

11. Change the map size if desired. 

12. Click the Save button. 

 

 

13. You will se the Configuration 

updated message. 
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Inserting a Google Map in a Post or Page 
7. Pull up the Google map (http://maps.google.com/) you want to embed.  

8. Click the “Link to this page” option.  

 

 

 

 

 

 

 

9. Copy the link in the “Paste link in 

email or IM” field. 

 

 

 

 

 

10. Access the post or page on which you want to include 

the map.  

11. Type in a title for the map.  

12. Highlight your title. 

 

 

 

 

13. Click the link button .  

14. Paste in the URL.  

15. Click the Insert button. The map is going to appear, not just 

this test link. Really! 

16. To preview the map. Click the Save and Continue Editing 

button. Then click Preview. If you like what you see click 

Save or Publish. 
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Inserting HTML code in the side bar 
This can be used to insert html from sites like flickr, meez, zoho polls, etc.  

 

1. From your dashboard click 

Presentation. 

2. Choose Sidebar Widgets. (If 

sidebar widgets not available 

for the presentation you have 

chosen then you cannot do 

this, unless you choose a 

different presentation with 

widgets.) 

3. You can see the Widgets and 

how they are currently placed 

on the Sidebars. To add a Text 

box, locate one in your 

Available Widgets box and drag 

it up to the appropriate location 

on a side bar.  
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If you don’t have any text boxes available, scroll down to Text Box widgets and up the 

number by 1. Click Save. A new Text box should now be available. 

 
4. Click on the button in the new text box in your sidebar and it opens to receive 

content.  

 

 
 

5. Paste your html code into this box with a right click. 

6. Click the X to close it. 

7. Click the Save Changes button. 
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Adding Your Own Set of Subscription Chicklets to 

your Sidebar 
 

1. Access the RSS Button Maker site to generate the html code. 

http://www.toprankblog.com/tools/rss-buttons/ 

 

2. First, check the buttons you want. 

 

 
3. Then choose Default for 

the Code Type. 

4. Enter your feed 

information. 

5. Click Create Buttons. 
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6. Copy and paste the provided code into a sidebar widget on your blog. (See the 

previous section for directions on doing this.) 

 

 

 

Inserting a Hyperlink in a Comment  
In comments, you need to manually enter the hyperlink using HTML code.  

Type it exactly as shown. 

 

<a href=”url”>Title of link</a> 

Example: <a href=”http://jgarton.edublogs.org”>Fusion Finds</a> 

 

 

 

 


